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Accessibility for People with Disabilities
Microsoft® is committed to making its products and services easier for everyone to 
use. The following topics provide information about the features that make 
Microsoft Dynamics GP® more accessible for people with disabilities. 

• Menu bar and toolbar keyboard shortcuts on page 1
• Microsoft Dynamics GP application window keyboard shortcuts on page 2
• Window navigation keyboard shortcuts on page 2
• Tools keyboard shortcuts on page 2
• Window-specific keyboard shortcuts on page 3
• Other common keyboard shortcuts on page 3
• Customizing toolbars on page 4
• Changing your display on page 5
• Macros overview on page 6
• Recording a macro on page 7
• Recording a data entry step on page 8
• Playing a macro on page 9
• Shortcuts overview on page 9
• Default shortcuts on page 10
• Creating shortcuts to Microsoft Dynamics GP windows on page 11
• Creating shortcuts to SmartList favorites on page 11
• Creating shortcuts to macros on page 12
• Creating shortcuts to Web pages on page 13
• Creating external shortcuts on page 13
• Renaming or deleting shortcuts and folders on page 14
• Creating a new shortcut folder on page 14
• Creating custom keyboard shortcuts on page 15
• Accessibility features of Microsoft Dynamics GP Help on page 15
• Accessibility features of Windows on page 17

The information in this document applies only to users who license Microsoft products in 
the United States. If you obtained this product outside of the United States, you can use the 
subsidiary information card that came with your software package or visit the Microsoft 
Accessibility Web site at http://www.microsoft.com/enable for a list of telephone numbers 
and addresses for Microsoft support services. You can contact your subsidiary to find out 
whether the type of products and services described in this section are available in your area. 
Information about accessibility is available in other languages, including Spanish and 
French.

Menu bar and toolbar keyboard shortcuts

Use keyboard shortcuts to select commands from Microsoft Dynamics GP menus 
and toolbars. The shortcut letter is underlined on the menu or toolbar when you 
press ALT. To access a menu using keyboard shortcuts, press ALT and the underlined 
letter of the menu that you want to access. For example, press ALT, A to display the 
Transactions menu and press ALT, F to display the File menu. To select a command 
from a menu by using the keyboard, press ALT and the underlined letter of the 
menu that you want to access, then select the underlined letter in the command 
name. For example, to open the Transaction Entry window, press ALT, A, F, G.

If you complete most of your tasks using the keyboard only, be sure to display the main 
toolbar in the Microsoft Dynamics GP application window so that you can access common 
windows using keyboard shortcuts. 

http://www.microsoft.com/enable
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Microsoft Dynamics GP application window keyboard 
shortcuts

Use the following shortcut keys to navigate quickly within the Microsoft Dynamics 
GP application window.

Window navigation keyboard shortcuts

Use the following shortcut keys to navigate quickly within a window. 

Tools keyboard shortcuts

Use these keyboard commands to activate the following Microsoft Dynamics GP 
tools.

Navigation Keyboard shortcut

Address Bar ALT + D

Search box ALT + S

Toolbars ALT

Move to next toolbar command CTRL + TAB

Move to previous toolbar command CTRL + SHIFT + TAB

Home CTRL + 1

Second through ninth navigation pane button CTRL + number of 
navigation pane button. 
For example, press CTRL + 
2 to activate the second 
navigation pane button.

Forward and Back buttons ALT + RIGHT OR LEFT ARROW

Navigation Keyboard shortcut

Move to next field TAB

Move to previous field SHIFT + TAB

Move from scrolling window to next field CTRL + TAB

Move from scrolling window to previous field SHIFT + CTRL + TAB

Default button on a window ENTER

Close the current window CTRL + W

Exit application ALT + X

Tool Keyboard shortcut

Report Writer ALT + F9

Modify Current Report CTRL + F9

Modifier ALT + F10

Modify Current Window CTRL + F10

Record a Macro ALT+ F8

Play a Macro CTRL + F8



A C C E S S I B I L I T Y F O R P E O P L E W I T H D I S A B I L I T I E S 3

Window-specific keyboard shortcuts

Use the following shortcut keys to open the windows listed below.

Other common keyboard shortcuts

You can use the following shortcut keys instead of choosing command buttons in 
Microsoft Dynamics GP windows.

Window Keyboard shortcut

Assembly Entry — Decrease Level CTRL + D

Assembly Entry — Increase Level CTRL + I

Edit Payables Checks — Create Temporary Vendor CTRL + T

Edit Purchase Order Status— Display Vendor Item Detail CTRL + D

Payables Manual Payment Entry — Create Temporary Vendor CTRL + T

Payables Transaction Entry — Create Temporary Vendor CTRL + T

Purchase Order Entry — Create Temporary Vendor CTRL + T

Purchase Order Entry — Display Vendor Item Detail CTRL + D

Purchase Order Entry — Open Item Detail CTRL + E

Purchase Order Inquiry Zoom — Display Vendor Item Detail CTRL + D

Purchase Order Inquiry Zoom — Open Item Detail CTRL + E

Purchase Order Processing Item Inquiry — Display Vendor Item Detail CTRL + D

Purchasing Invoice Entry — Display Vendor Item Detail CTRL + D

Purchasing Invoice Entry — Open Item Detail CTRL + E

Purchasing Invoice Entry — Open Match Shipments to Invoice CTRL + M

Purchasing Invoice Inquiry Zoom— Display Vendor Item Detail CTRL + D

Purchasing Item Detail Entry — Display Vendor Item Detail CTRL + D

Purchasing Item Detail Inquiry Zoom — Display Vendor Item Detail CTRL + D

Purchasing Item Receipts Zoom — Display Vendor Item Detail CTRL + D

Purchasing Vendor Detail Entry — Create Temporary Vendor CTRL + T

Receivings Item Detail Entry — Display Vendor Item Detail CTRL + D

Receivings Transaction Entry — Create Temporary Vendor CTRL + T

Receivings Transaction Entry — Display Vendor Item Detail CTRL + D

Receivings Transaction Entry — Open Item Detail CTRL + E

Receivings Transaction Inquiry Zoom — Open Item Detail CTRL + E

Receivings Transaction Inquiry Zoom— Display Vendor Item Detail CTRL + D

Sales Transaction Entry — Open Item Detail CTRL + E

Sales Transaction Entry— Quick Print CTRL + Q

Select Purchase Order Items — Display Vendor Item Detail CTRL + D

Vendor Account Maintenance — Open Additional Vendor Accounts CTRL + E

Command Keyboard shortcut

Copy CTRL + C

Paste CTRL + V

Print CTRL + P

Select All CTRL + A

View Functional Currency CTRL + U

View Originating Currency CTRL + O

View Reporting Currency CTRL + R



 

4 A C C E S S I B I L I T Y F O R P E O P L E W I T H D I S A B I L I T I E S

Customizing toolbars

The Microsoft Dynamics GP toolbars contain specific tasks that you can complete 
for selected categories, such as transactions or cards, and are customizable on a per-
user basis. You can use the Toolbar Customization window to customize the 
toolbars available to you. You can add commands to toolbars, as well as customize 
the appearance of commands. You also can remove commands from a toolbar. See 
the System User's Guide (Help >> Contents >> Select Using The System) for more 
information about the Microsoft Dynamics GP toolbars.

To customize a toolbar:
1. Open the Toolbar Customization window

(Layout menu >> Toolbars >> Customize)

2. Select a toolbar to add a window or command to.

3. Choose Add to open the Add Command window.

4. Choose a menu from the menu groups listed. 

5. In the Categories/Commands pane, expand a category to display the windows 
and commands in it, select a category or a command from the list.

6. Choose OK. 

Account Alias CTRL + Q

Analysis CTRL + Y 

Command Keyboard shortcut
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The following table contains other actions you can complete to customize toolbars. 
After you have finished customizing toolbars, choose OK to save your changes and 
close the window.

Changing your display

Use the User Display Preferences window to change how Microsoft Dynamics GP 
looks on your computer. You can select the colors and styles for links, required and 
editable fields, and the alternating lines in the scrolling windows that appear in 
Microsoft Dynamics GP windows.

If you have low vision, you can use the Accessibility Wizard available with your 
operating system to select a high contrast color scheme which removes color 
gradients from the user interface. You also can use the Display Properties window 
available with your operating system to specify additional color settings that might 
improve visibility of the user interface.

Since many fields in Microsoft Dynamics GP are editable, be sure to choose a combination of 
colors and patterns that is easy to look at for long periods of time. 

Action Procedure

Reset Toolbar Select a toolbar to reset from the drop-down list. Choose Reset 
Toolbar to change the selected toolbar back to the default 
settings.

Delete a command Choose a toolbar from the drop-down list. Select a command in 
the controls pane, then choose Delete to remove that command 
from the selected toolbar.

Change the order of 
commands on a toolbar

Choose a toolbar from the drop-down list. Select a command in 
the controls pane, then choose Move Up or Move Down to move 
the selected command to another position on the toolbar. 

Rename a command Choose a toolbar from the drop-down list. Select a command in 
the controls pane, then choose Modify Selection >> Name to 
open the Change Name window. Enter a new name for the 
command and choose OK to save your changes and close the 
window. 

If you are renaming a command to have an ampersand (&) or a 
pound (#) symbol in it, you must first enter a backward slash (\) 
before the symbol. Without the “\” a pound sign appears as 
ellipses (...). The “&” makes the first letter of the word that is 
entered after it underlined in the menus. 

Change a command icon Choose a toolbar from the drop-down list. Select a command in 
the controls pane, then choose Modify Selection >> Change 
Button Image to open the Change Icon window. Select a new 
icon and choose OK to save your changes and close the window.

Only show name of 
command on the toolbar

Choose a toolbar from the drop-down list. Select a command in 
the controls pane, then choose Modify Selection >> Text Only. 

Only show icon of command 
on the toolbar

Choose a toolbar from the drop-down list. Select a command in 
the controls pane, then choose Modify Selection >> Image only.

Show name and icon of a 
command on the toolbar

Choose a toolbar from the drop-down list. Select a command in 
the controls pane, then choose Modify Selection >> Image and 
Text.

Use the default style to show 
a command on the toolbar

Choose a toolbar from the drop-down list. Select a command in 
the controls pane, then choose Modify Selection >> Default 
Style.

Divide a toolbar for easier 
viewing (insert a divider line)

Choose a toolbar from the drop-down list. Select the command 
that the divider line comes before from the contents pane. 
Choose Modify Selection >> Insert Divider Line
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To change your display:
1. Open the User Display Preferences window. 

(Microsoft Dynamics GP menu >> User Preferences >> Display button)

2. In the Link Fields group, specify how you want links to look.

3. In the Required Fields group, specify how you want required fields to look. 

You can display field names in a specific color and style by selecting the Show 
Required Fields option on the Help menu. 

4. Choose Apply and use the Preview window to view your selections.

5. When you’ve finished making changes, choose OK to close the window and 
save your changes. Choose OK to close the User Preferences window.

Macros overview

A macro is a recording of each key you pressed or mouse click you made while 
performing a procedure. (You could think of creating a macro as a “recording 
session.”) Later, the macro can be played. As it is played, each entry is re-created 
just as though you were typing the keystrokes and using the mouse yourself.

Although a macro can begin anywhere within Microsoft Dynamics GP, the point where a 
macro begins must be active before you can play it. For example, if you begin recording a 
macro using the General System Reports window, that window must be active on your 
screen for the macro to play. We recommend that you begin every macro by making a 
selection from the menu bar or toolbar.
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Recording a macro

Although you can create macros for any entries you make in the Microsoft 
Dynamics GP system, macros typically are most effective for the following tasks: 

• Printing routine reports that can be compiled the same way at regular intervals.

• Performing one or more tasks that require lengthy computer processing time. 
You can begin replaying the macro when you’re ready to go home for the 
evening or a weekend. The macro automatically completes the task and, if you 
want, exit the Microsoft Dynamics GP system when it is finished.

• Standardizing the completion of crucial accounting tasks, such as posting, 
printing financial statements, or closing a month or a year.

The following table lists all the menu options available while recording a macro.

After the macro is recorded, you can edit it using a text editor, such as Notepad. To 
delete a particular Microsoft Dynamics GP macro, you can either record a new 
macro using the same name, or delete the macro’s file at the operating system level.

To record a macro:
1. Start from the menu bar. Doing so makes it easy to remember where you started 

your macro from. You’ll need to know the point where the macro began to be 
able to replay the macro.

2. On the Microsoft Dynamics GP menu, choose Tools >> Macro >> Record to 
display the Name the macro window.

3. Specify a name and location for the macro using naming conventions:

• Make the filename descriptive (for example, a macro might be named 
YTDIncome.mac).

• Use the .MAC extension to indicate that it’s a macro.

• Save all your macros in a folder. Otherwise, the macro is saved in the main 
folder for your system. If you are using Microsoft Windows Vista®, files 
can’t be saved to the folder where Microsoft Dynamics GP program files are 
stored, typically C:\Program Files\Microsoft Dynamics\GP.

To program the macro so that you can enter data while playing a macro, see 
Recording a data entry step on page 8.

Recording option Description

Record Displays the dialog box where you specify the macro’s name and 
location.

Stop Record Ends the recording of the macro.

Suspend Recording Allows you to enter a prompt that appears when the macro is 
played; the macro is paused, as well. Choose Resume Recording to 
continue recording.

Resume Recording Continues recording the macro after recording is suspended, if you 
used the Suspend Recording option.

Insert Pause Pauses the recording of the macro.See Recording a macro on page 7 
and Recording a data entry step on page 8 for more information.
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4. Perform the procedure to be recorded.

When you record a macro, use keyboard commands rather than your mouse as much as 
possible. If you edit the macro later in Notepad, it is easier to find the commands and 
steps to change.

5. Stop the macro. 
(Microsoft Dynamics GP menu >> Tools >> Macro >> Stop Record)

Recording a data entry step

If the procedure you’re recording requires that the user enter additional information 
or perform certain actions each time the macro is played, you can insert pauses in 
the macro at selected points and add a message that is displayed when the macro 
pauses. 

When you play the macro, it pauses at these points, allowing you to take the 
necessary action and then continue playing the macro. For instance, you may want 
to insert a macro pause before a report is printed by the macro. The message could 
prompt the user to verify printer setup before continuing playback. After printer 
setup has been verified, the user would continue playing the macro (Microsoft 
Dynamics GP menu >> Tools >> Macro >> Continue).

To record a data entry step: 
1. Complete steps 1 through 4 in the Recording a macro on page 7 procedure.

2. When you reach the point where you need to enter data or perform an action, 
on the Microsoft Dynamics GP menu, choose Tools >> Macro >> Insert Pause. 
The Macro Insert Pause window appears. 

3. Enter a message that instructs the user to complete the action needed before 
continuing playback. The message appears at the specified point when you play 
back the macro.

4. Choose OK.

5. On the Microsoft Dynamics GP menu, choose Tools >> Macro >> Resume 
Recording to restart the recording.

6. Repeat steps 2 through 5, as necessary, until you are finished recording the 
macro.

7. Stop the macro. 
(Microsoft Dynamics GP menu >> Tools >> Macro >> Stop Record)
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Playing a macro

You can play Microsoft Dynamics GP macros in the following ways:

• On the Microsoft Dynamics GP menu, choose Tools >> Macro >> Play.

• Add a shortcut for the macro. See the System User's Guide (Help >> Contents 
>> Select Using The System) for more information about the shortcuts.

• Add the macro to a list of routines, and select it from the list of routines. See the 
System Administrator’s Guide (Help >> Contents >> select System 
Administration) for more information on customizing routines.

To play a macro:
1. On the Microsoft Dynamics GP menu, choose Tools >> Macro >> Play. The 

Select a Macro to Play window is displayed.

2. Select the macro to play and choose Open. The macro begins playing.

3. To control how the macro plays, select one of the playback options.

The options are listed in the following table.

4. If a prompt appears as the macro is running, complete the requested action and 
choose OK.

Shortcuts overview

Shortcuts are displayed in the upper part of the navigation pane when your Home 
Page is displayed. If the navigation pane is not visible, choose the Layout menu and 
select Navigation Pane. Choose the Home navigation pane button to display your 
shortcuts and your home page. See the System User's Guide (Help >> Contents >> 
Select Using The System) for more information about the navigation pane and home 
pages.

Playback option Description

Play Displays a dialog box that contains all the macros in the 
current folder that were assigned a .MAC extension.
After you select a macro to play, the Macro menu displays 
up to four options: Stop Play, Pause, Step, and Continue.

Stop Play Stops playing the macro.

Pause Pauses the macro until you choose Continue or Step.

Step Allows you to play the macro one line at a time. For 
instance, if your macro doesn’t run through successfully, 
this option allows you to follow the process of the macro, 
step by step, to determine where the problem is.
The macro does not step through a dialog box one line at a 
time because the Step option is not available when a dialog 
box is displayed.

Continue Continues playing the macro after play is paused, if the 
Pause option was used when recording the macro.
If the Insert Pause option was used when recording, a dialog 
box appears when you play the macro, displaying a prompt. 
This prompt was entered in the Macro Insert Pause window. 
Choose OK in the dialog box, enter or verify the appropriate 
data, then choose Continue from the Macro menu.
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Use shortcuts to quickly open frequently used windows and resources within 
Microsoft Dynamics GP. For example, if you regularly access a small subset of 
windows in your daily tasks, you can create shortcuts to those windows and store 
them in one folder. You can do the same with windows that you use less frequently, 
such as those used for month-end closing procedure. Besides creating shortcuts for 
Microsoft Dynamics GP windows, you can create shortcuts to the following items:

• SmartList favorites
• Microsoft Dynamics GP macros
• Internet Web pages
• Other applications in your system

You can’t create two shortcuts with the same name at the same level in the list of shortcuts. If 
an existing shortcut has the same name as the one you’re creating, the shortcut appears with 
a number after the name.

The default set of shortcuts contain a Startup folder. Shortcuts that you move into 
this folder starts automatically when you log in to a company in Microsoft 
Dynamics GP.

Shortcuts also may include a User Classes folder. The User Classes folder is created 
for you by the system administrator and contains shortcuts to specific tasks and 
windows. The system administrator can modify and delete a User Classes folder or 
any other shortcuts within the folder.

The following table explains shortcut options that are available.

Default shortcuts

Default shortcuts are available to each new user created in Microsoft Dynamics GP. 
Select the default shortcuts for more information about using Microsoft Dynamics 
GP and to set up your user preferences. 

You can delete, move, or rename any of the following default shortcuts:

User Preferences Choose this shortcut to open the User Preferences window, 
where you can customize the way Microsoft Dynamics GP appears on your 
workstation, change your user password, and set other options.

Shortcuts Select the folder icon to expand this folder, which contains a shortcut 
to the CustomerSource Web site, where you can learn about available support 
options. The CustomerSource Web site requires login credentials.

Startup Organize shortcuts to specific windows to open and applications to start 
whenever you open a company in Microsoft Dynamics GP. 

Option Action

Open a shortcut Click the shortcut to open.

Open a shortcut in a folder Click a folder name to expand its contents and click the shortcut 
to open.

Add a new shortcut folder Right-click anywhere in the list of shortcuts and choose Add >> 
Folder. 

Move a shortcut into a folder Select the shortcut and drag it into a shortcut folder.

Delete a shortcut or folder Right-click the shortcut or folder and choose Delete.

Rename a shortcut Right-click the shortcut or folder and choose Rename.
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Creating shortcuts to Microsoft Dynamics GP 
windows

The most common type of shortcut you’ll create is a shortcut to a window within 
Microsoft Dynamics GP. You also can add shortcuts of multiple Microsoft Dynamics 
GP windows at one time to group them in a shortcut folder.

To create a shortcut to the current Microsoft Dynamics 
GP window:
1. Open the window to add a shortcut for.

2. Choose File >> Add to Shortcuts.

To create shortcuts to several Microsoft Dynamics GP 

windows:
1. Right-click anywhere in the list of shortcuts and choose Add >> Add Window. 

2. The Add Window Shortcut window appears. 

3. Enter a name for the shortcut in the Name field. The name can be up to 79 
characters long.

4. From the Available Windows list, locate and select a window to create a 
shortcut for.

5. Choose Add to create a shortcut to the window.

6. To create additional shortcuts, repeat steps 3 through 5 for each window to 
create a shortcut for.

7. Choose Done to close the Add Window Shortcut window. 

Creating shortcuts to SmartList favorites

You can quickly access the information stored in your Microsoft Dynamics GP data 
that you regularly refer to by adding shortcuts to SmartList favorites. See the 
System User’s Guide (Help >> Contents >> Select Using The System) for more 
information about SmartList.
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To create a shortcut to a SmartList favorite:
1. Right-click anywhere in the list of shortcuts and choose Add >> Add SmartList. 

2. The Add SmartList Favorite Shortcut window appears.

3. From the list of available SmartList Favorites, locate and select the favorite to 
create a shortcut for. The favorite appears in the SmartList favorite field. 

4. Accept or enter the name for the SmartList favorite in the Name field. The name 
can be up to 79 characters long. 

5. Choose Add to create a shortcut to the favorite.

6. To create additional SmartList favorite shortcuts, repeat steps 3 through 5 for 
each SmartList favorite to create a shortcut for.

7. Choose Done to close the Add SmartList Favorite Shortcut window. 

Creating shortcuts to macros

By creating shortcuts to macros that you frequently use, you can start the macros 
from the main Microsoft Dynamics GP window. 

To create a shortcut to a macro:
1. Right-click anywhere in the list of shortcuts and choose Add >> Add Macro. 

2. The Add Macro Shortcut window appears.

3. Enter a name for the macro. The name can be up to 79 characters long.
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4. Choose Browse to locate the macro to add. The Select a Macro window appears. 
After you locate and select the macro, choose Open to add it to the Macro file 
field in the Add Macro Shortcut window.

5. Choose Add to create a shortcut to the macro.

6. To create additional macro shortcuts, repeat steps 3 through 5 for each macro to 
create a shortcut for.

7. Choose Done to close the Add Macro Shortcut window. 

Creating shortcuts to Web pages

If you regularly refer to Web pages or Web sites to complete your Microsoft 
Dynamics GP tasks, you can add shortcuts to those pages and access them quickly 
without having to enter the address in your Web browser application.

To create a shortcut to a Web page:
1. Right-click anywhere in the list of shortcuts and choose Add >> Add Web Page. 

2. The Add Web Page Shortcut window appears. 

3. Enter a name for the Web page in the Name field. The name can be up to 79 
characters long.

4. Enter the Web page address in the Address field. 

To verify the address that you entered, choose the Test button. Your default Web browser 
starts and attempt to open the Web page.

5. Choose Add to create a shortcut to the Web page.

6. Repeat steps 3 through 5 for each Web page to create a shortcut for.

7. Choose Done to close the Add Web Page Shortcut window. 

Creating external shortcuts

You can create shortcuts to external tasks by using the Add External Shortcut 
window. 

To create an external shortcut:
1. Right-click anywhere in the list of shortcuts and choose Add >> Add External 

Shortcut.
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2. The Add External Shortcut window appears.

3. Enter a name for the application or file in the Name field. 

4. Choose the Browse button to locate the external application or file to add. The 
Select an Application window appears.

5. Select a program or file. Choose Open to add its path to the Command Line 
field in the Add External Shortcut window.

6. Choose Add to create a shortcut to the file.

7. Repeat steps 3 through 6 for each external shortcut you want to create.

8. Choose Done to close the Add External Shortcut window. 

Renaming or deleting shortcuts and folders

After you’ve created a shortcut, you can modify its name. To rename a shortcut, 
complete one of the following actions.

• Right-click on the shortcut or folder and choose Rename. 

• Right-click on the shortcut and choose Shortcut Properties. Type a new name in 
the Shortcut Properties window. 

To delete a shortcut or folder, complete the following action.

• Right-click the shortcut or folder and choose Delete.

If you delete a folder, all the shortcuts and subfolders contained within it also are 
deleted. 

Creating a new shortcut folder

You can organize shortcuts by grouping them into folders on the shortcut bar. For 
example, you may want to group shortcuts for a series of tasks in the same folder, or 
put shortcuts for the same type of files in one folder.

To create a new shortcut folder:
1. Right-click anywhere in the list of shortcuts and choose Add >> Folder.

2. A folder appears with the default name New Folder. 

3. Enter a name for the folder.
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You can’t create two folders with the same name at the same level of the shortcut bar. If 
an existing folder has the same name as the one you want to create, the folder appears 
with a number after the name.

Creating custom keyboard shortcuts

You can apply a series of keystrokes to activate a shortcut using the keyboard. You’ll 
choose from a list of available keyboard shortcuts to assign the keystrokes. Any 
keys used for keyboard commands by the operating system, the main Microsoft 
Dynamics GP menus, or other shortcuts won’t be available to use for custom 
keyboard shortcuts.

To create a custom keyboard shortcut:
1. In the list of shortcuts, right-click on the shortcut to assign a keyboard shortcut 

to and choose Shortcut Properties. The Shortcut Properties window opens.

2. Choose a keyboard shortcut from the available keystrokes in the Keyboard 
Shortcut drop-down list.

3. Choose OK.

Accessibility features of Microsoft Dynamics GP Help

Microsoft Dynamics GP Help includes features that make it accessible to a wider 
range of users, including those who have limited dexterity, low vision, or other 
disabilities.

In addition, Microsoft Dynamics GP printable manuals are available on the Web.

Keyboard shortcuts for using the Help window
By using the following keyboard shortcuts in Help, you can quickly accomplish 
many common tasks.

To do this Use this keyboard shortcut

Display the Help window F1

Switch the cursor between the Help topic pane 
and the navigation pane (tabs such as Contents, 
Search, and Index).

F6

Change between tabs (for example, Contents, 
Search, and Index) while in the navigation pane.

ALT + Underlined letter of the tab

Expand or collapse bookmarks in the Contents 
tab.

RIGHT ARROW or LEFT ARROW

Select the next hidden text or hyperlink. TAB

Select the previous hidden text or hyperlink. SHIFT + TAB

Perform the action for the selected Show All, Hide 
All, hidden text, or hyperlink.

ENTER
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To use the keyboard to navigate to Help topics about 
Accessibility features:
1. Start Microsoft Dynamics GP and use one of the following methods to display 

Help:

• To display Help with information about the current window, press F1.
• To display the main “contents” topic, press ALT + H + C.
• To display Help with the Index tab showing, press ALT + H + I.

2. If the navigation pane is not showing, press ALT + O, and then press T.

3. If the Contents tab of the navigation pane is not showing, press ALT + C.

4. Use the arrow keys to browse the bookmarks and select the accessibility topic.

5. Alternatively, display the Index or Search tabs, and search for the term 
“accessibility”.

To change the appearance of a Help topic:
1. To customize the colors, font styles, and font sizes used in Help, open the Help 

window.

2. Click Options, and then click Internet Options.

3. On the General tab, click Accessibility. Select Ignore colors specified on Web 
pages, Ignore font styles specified on Web pages, and Ignore font sizes specified 
on Web pages. You also can choose to use the settings specified in your own 
style sheet.

4. To change the colors used in Help, or to change the font, refer to the following 
procedures.

Display the Options menu to access any Help 
toolbar command.

ALT + O

Hide or show the pane containing the Contents, 
Search, and Index tabs.

ALT + O, and then press T

Display the previously viewed topic. ALT + O, and then press B

Display the next topic in a previously viewed 
sequence of topics.

ALT + O, and then press F

Return to the specified home page. ALT + O, and then press H

Stop the Help window from opening a Help topic 
(useful if you want to stop a Web page from 
being downloaded).

ALT + O, and then press S

Open the Internet Options dialog box for 
Microsoft Internet Explorer®, where you can 
change accessibility settings.

ALT + O, and then press I

Refresh a topic (useful if you have linked to a Web 
page).

ALT + O, and then press R

Print all topics in a book or a selected topic only. ALT + O, and then press P

Close the Help window. ALT + F4

To do this Use this keyboard shortcut
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To change the color of the background or text in Help:
1. Open the Help window.

2. Click Options, and then click Internet Options.

3. On the General tab, click Accessibility. Then select Ignore colors specified on 
Web pages. You also can choose to use the settings specified in your own style 
sheet. 

4. To customize the colors used in Help, on the General tab, click Colors. Clear the 
Use Windows Colors check box, and then select the font and background colors 
that you want to use.

If you change the background color of the Help topics in the Help window, the change 
also affects the background color when you view a Web page in Microsoft Internet 
Explorer.

To change the font in Help:
1. Open the Help window.

2. Click Options, and then click Internet Options.

3. On the General tab, click Accessibility. To use the same settings as those used in 
your instance of Microsoft Internet Explorer, select Ignore font styles specified 
on Web pages and Ignore font sizes specified on Web pages. You also can choose 
to use the settings specified in your own style sheet. 

4. To customize the font style used in Help, on the General tab, click Fonts, and 
then click the font style you want.

If you change the font of the Help topics in the Help window, the change also affects the 
font when you view a Web page in Internet Explorer.

Accessibility features of Windows

The Windows® operating system has many built-in accessibility features that are 
useful for individuals who have difficulty typing or using a mouse, are blind or 
have low vision, or who are deaf or hard-of-hearing. The features are installed 
during setup. For more information about these features, see Help in Windows and 
the Microsoft Accessibility Web site at http://www.microsoft.com/enable.

Free step-by-step tutorials
Microsoft offers a series of step-by-step tutorials that provide detailed procedures 
for adjusting the accessibility options and settings on your computer. This 
information is presented in a side-by-side format so that you can learn how to use 
the mouse, the keyboard, or a combination of both. 

To find step-by-step tutorials for Microsoft products, see the Microsoft Accessibility 
Web site.

http://www.microsoft.com/enable
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Assistive technology products for Windows
A wide variety of assistive technology products are available to make computers 
easier to use for people with disabilities. You can search a catalog of assistive 
technology products that run on Windows at the Microsoft Accessibility Web site.

If you use assistive technology, be sure to contact your assistive technology vendor 
before you upgrade your software or hardware to check for possible compatibility 
issues. 
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